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PREFACE

TRADEMARKS ©® AND COPYRIGHTS ©

Scanivalve is a registered trademark of Scanivalve Corpora-
tion.

All other brand and product names are trademarks or regis-
tered trademarks of their respective companies.

IMPORTANT NOTICE

Please note that the product specifications and other
information contained in this manual are subject to change
without notice. Scanivalve Corporation makes an effort and
strives to provide complete and current information for the
proper use of the equipment. If there are any questions
regarding this manual or the proper use of the equipment,
contact Scanivalve Corporation.

CONTACT INFORMATION

If there are any questions or concerns regarding any Sca-
nivalve product please do not hesitate to contact us at the
following:

Scanivalve Corp.
1722 N. Madson Street
Liberty Lake, WA 99019
Telephone: (800)935-5151 (509)891-9970
Fax: (509)891-9481
scanco@scanivalve.com
www.scanivalve.com

Scanivalve Corporation is an 1ISO9001:2000 certified com-
pany.

BT v Scanivatve corn. .
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SECTION 1: INTRODUCTION

SENSOR REPLACEMENT UTILITY

SECTION 1: INTRODUCTION

OVERVIEW

The Sensor Replacement Utility was developed as an easy
to use method to move sensor coefficients. It is compatible

with:

o DSA3007 o DSA3018

o DSA3207 o DSA3217

o DSA3307 o DSA3218

o DSA3017
4,

The software is designed to upload and download Sensor

Profile Files (.spf files). 5.
6.

SYSTEM REQUIREMENTS

CENNN—— 2|

= Type the name of a program, Folder, document, or
B Internet resource, and Windows will open it for vou.

Open: || j

oF I Cancel | Browse. .. |

Open the drive where the CD is installed, highlight
Setup.exe and click Open.

Click Ok in the ‘Run” window to begin the installation.
Follow the on screen prompts to complete the instal-
lation.

If the Sensor Replacement Utility has been downloaded

Windows XP SP3 from the Scanivalve website, unzip the file and double-click
Windows 7 the Setup.exe file. Follow the on screen prompts to com-
Pentium IV or better processor plete the installation.

512 Mb RAM

Microsoft Framework.net V2.0 or higher*

* NET Framework is available as a free download from Microsoft

INSTALLATION

To install the software,
1. Place the installation CD in a CD or DVD drive
2. Click Start, then Run.

==
5’7 Microsoft Update
@ Set Program Access and Defaults

R Windows Catelog

% Windows Update

% WinZip

:, Programs »

'ﬁ Documents 3

e

Windows XP Professional

Ry RN

3. Select Browse.
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SENSOR REPLACEMENT UTILITY

OPERATION

SECTION 2: OPERATION

GETTING STARTED

The main window of the Sensor Replacement Utility can be
seen in Figure 2.1. It is made up of the menus across the
top in traditional Windows format, the IP address field, the
channel number field and the status panel.

DSA Sensor Replacement Utility 8

File  Configuration  Help
DS 1P Address: |1D.D.D.1D

Clear Statuz Panel I

=10l =|

D54 Sensor Position: I 1 3:

Starting D54 Senzor Replacement Utility, Wersion 0.90] ;I
Last IP address was 10.0.0.10
Last channel number wasz 1

FIGURE 2.1 - MAIN WINDOW

Under the File menu (Figure 2.2) are three options:

‘Create SPF..." - This option downloads coeficients from
a specified channel of a specified module and creates a
Sensor Profile File (.spf).

‘Open SPF..." - This option uploads a Sensor Profile File
(.spf) to the specified channel of a specified module.

DSA Sensor Replacement Utility i ] |

File | Configuration  Help
Create SPF.... s
D54 Sensor Position: I 1 3:
Open SPF....
Exit I
Starting DS54 Senzor Replacement Utility, Yersion 0,90 ;I

Last IP address was 10.0.0.10
Last channel number was 1

‘Exit’ - This option closes the Senor Replacement Utility.
Under the Configuration menu (Figure 2.3) is one option:

‘Debug’ - This option either enables or disables additional
debug information to be printed to the status panel. This
information is not needed for most applications however

it provides useful information when trying to understand

problems with the software.

L=
File | Configuration | Help
Debug %
D54 o= DS54 Sensor Pozition: I 1 3:
| Clear Status Panel I
Starting D54 Senzor Replacement Utility, Yerzsion 0.90] ;I
Last IP address was 10.0.010
Last channel number was 1

FIGURE 2.3 - CONFIGURATION WINDOW

The Help menu (Figure 2.4) provides one option:

‘About’ - This option provides basic information about the
Sensor Replacement Utility including the software version.

=
File  Configuration | Help
About
DSA IP Address: [10.4we D34 Sensor Position: | 1=

| Clear Statuz Panel I

Starting DSA Sensor Replacement Utility, Vergion 0.90j ;I
Last IP address was 10.0.0.10
Last channel number wasz 1

FIGURE 2.2 - FILE MENU
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FIGURE 2.4 - HELP MEENU




SECTION 2: OPERATION SENSOR REPLACEMENT UTILITY

The DSA IP Address field (Figure 2.5) is a configurable field =10j=|
used to define the IP Address of the DSA module being Al CORIEEER als
communicated with. Simply enter the IP Address of the DSAIFAddess [100010  DSASensorPostion: | 1]
DSA module being communicated with before attempting
to establish a connection. | Clear Status Panel |
DSA Sensor Replacement Utility o ] | ‘
File  Configuration  Help E;:rttilr;ga[ﬁ.i Ssseasazr%n?glgﬁea‘nent Utility, Wersion 090 ;I
Last channel numb 1
DSA IP Address: W DS54 Sensar Position: Iﬂ SEEmRAnSmeR At
Clear Statuz Panel I
Starting DS54 Senzor Replacemment Utility, Wergion 0,90) ;I
Last P address wase 10.0.0.10 LI
Laszt channel number was 1 k j
FIGURE 2.7 - STATUS PANEL
The ‘Clear Status Panel’ button (Figure 2.8) is located
H above the Status Panel. When clicked, all text displayed
in the Status Panel is cleared. The data displayed in the
Status Panel can very quickly become cluttered and difficult
FIGURE 2.5 - IP ADDRESS FIELD to sort through, this feature makes it very easy to eliminate
unwanted data.
The DSA Sensor Position field (Figure 2.6) is a configurable (ol

field used to define the position that the Sensor Profile

File. Configuration  Help
File (.spf) will be uploaded to or downloaded from. This

field uses 1-16 channel numbering*. The channel can DS54 IP Address: |1D.D.D.1D 'S4 Sensor Position: I 13:
be changed by either clicking the up and down arrows or | |
. . Clear Status Panel
manually entering the desired channel. el
;IEIEI Starting D54 Senzor Replacement Utility, Wersion 0.90] ;l
File  Comfiguration  Help Last IP address was 10.0.0.10

Last channel number was 1

DSA IP Address: I‘ID.D.D.‘ID D54 Sensor Position: I 1 3:

Clear Status Panel I

Starting DSé Senzor Replacement Utiliby, Yerzion 0.90) d
Last IP address was 10.0.0.10
Last channel number was 1

[

FIGURE 2.8 - CLEAR STATUS PANEL BUTTON

[

FIGURE 2.6 - DSA SENSOR POSITION FIELD

The Status Panel (Figure 2.7) is a text window on the main
screen that displays information about the configuration
and activity during a Sensor Profile File (.spf) creation

or upload. The text in the Status Panel is not editable,
however it can be selected, copied and pasted into a text
document for review or archiving.

*NOTE: DSA software references channel 0-15, while the hardware is numbered 1-16. The Sensor Replacement Utility uses 1-16 numbering.

BT ¢ scaniatve corp. . %



SENSOR REPLACEMENT UTILITY

CREATING A SENSOR PROFILE FILE (.SPF)

The ability to create a Sensor Profile File (.spf) is used when
a sensor is being moved from one position to another. This
can also be done between modules. The procedure for
removing and replacing sensors is covered in detail in the
appropriate DSA hardware manual. Take great care with
procedure as damage can easily be done to the sensor and/
or the module. It is recommended before moving a sensor
from one module to the next you contact Scanivalve Corp.
to confirm compatibility.

Before removing the sensor from the original module, a
Sensor Profile File (.spf) should be created. The .spf file
contains all of the sensor’s unique calibration coefficients
as well as it’s associated configuration variables.

Begin by configuring the Senor Replacement Utility.

1. Enter the IP Address of the module being communi-
cated with in the DSA IP Address field*.

2. Select the sensor position (channel number) in the DSA
Sensor Position field.

3. Under the ‘Configuration’ menu, enable or disable the
‘Debug’ function as desired.

4. Under the ‘File’ menu, select ‘Create SPF...".

B DSA Sensor Replacement Ukility 1

File | Configuration Help
Create SPF.... ] -
D5A Senszor Position: I 1 3:
Open SPF....
Exit I
Starting D54 Sensor Replacement Utility, \ersion 040 ;I

Last IP address wasz 10.0.0.10
Last channel number was 1

SECTION 2: OPERATION

savens 21
Save jr: l@ Desktop j 0 j,' B
BMy Documents
ﬂ My Computer
‘dMy Metwork Places
@DTS Compare
File hame: I j Save I
Save as type: ISEnSUI Profile Files [".spf) j Cancel |

Z

=10

FIGURE 2.9 - CREATE SPF

5. A window will open to allow you to input the desired
name of the Sensor Profile File (.spf) to be created.
Navigate to the desired directory where the .spf file
will be created, then put the desired file name of the
.spf file in the ‘File Name’ field.

FIGURE 2.10 - SAVE .SPF FILE

6. Click ‘Save’ and the Sensor Replacement Utility will
create the Sensor Profile File (.spf) in the specified
location.

7. Navigate to the specified directory and confirm that
the Sensor Profile File (.spf) was successfully created.

A Sensor Profile File (.spf) can be opened and viewed using
any text editor such as Notepad or Microsoft® Word.

*NOTE: Ensure that the IP Address of the module is compatible with the IP Address of the host computer. For more information on this, contact Scanivalve.
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SENSOR REPLACEMENT UTILITY

SECTION 2: OPERATION

open 21|

UPLOADING A SENSOR PROFILE FILE (.SPF)

When a sensor is relocated in a DSA module or a new
sensor is installed the unique calibration coefficients associ-
ated with the sensor need to be uploaded to the module.
The Sensor Profile File (.spf) contains all of these unique
calibration coefficients as well as the configuration vari-
ables associated with the sensor.

All replacement sensors are delivered from Scanivalve with
the associated Sensor Profile File (.spf). If the sensor is
being removed from another module, the Sensor Profile
File (.spf) can also be created from the old module before
the sensor is removed using the Sensor Replacement Util-
ity. See the “Creating a Sensor Profile File (.spf)” section of
this manual for more information on creating .spf files.

To upload a Sensor Profile File (.spf), begin by configuring
the Sensor Replacement Utility software:

1. Enter the IP Address of the module being communi-
cated with in the DSA IP Address field*.

2. Select the sensor position (channel number) in the DSA
Sensor Position field.

3. Under the ‘Configuration’ menu, enable or disable the
‘Debug’ function as desired.

4. Under the ‘File’ menu, select ‘Open SPF...".

5. A window will open to allow you to select the desired

(¥ DSA Sensor Replacement Utility j

File | Configuration  Help
Create SPF.... —_ i
D54 Sensar Position: I q 3:
Open SPF....
Exit I
Starting DSA Sensar Replacerant Utility, Yersion 0,90] ;I

Last IP address waz 10.0.0.10
Last channel number was 1

Look i | () SRU 0.90) testing (117-11) EH @ &F 2 E:
ﬂ chanl.spf
ﬂ chani_bind.spf
ﬂ chan1_bin1.spf
ﬂ chanl_echal.spf
Desktop
tdy Documents
-
o
tdy Computer
File name: I j Open I
Files of type: ISansor Prafile Files [* 2pf] j Cancel

7

=10] x|

FIGURE 2.11 - OPEN SPF

Sensor Profile File (.spf) to be uploaded.

FIGURE 2.12 - SELECT .SPF FILE TO UPLOAD

6. Select ‘Open’ to begin uploading the Sensor Profile File

(.spf) to the DSA module.

7. To confirm that the upload was successful, connect

to the DSA module through Telnet, HyperTerminal or
another Ethernet communications venue. Send the
command:

list mi X0 69

(X = the sensor location the .spf file was uploaded to. Note that here a 0-15 channel
numbering system is used. If a .spf file was uploaded to channel 1 through the Sensor

Replacement Utility, ‘list mi 0 0 69" would display the uploaded coefficients.)
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SENSOR REPLACEMENT UTILITY

APPENDIX A - SAMPLE SENSOR

APPENDIX

PROFILE FILE (.SPF)

SET TEMPMO 595.000000

SET TEMPBO -14075.000000

SET ABSO O

SET MAX0 0.210000

SET MINO -0.210000

SET NEGPTSO 4

INSERT 0 0 -0.200240 -15093 M
INSERT 0 0-0.149860 -11376 M
INSERT 0 0-0.100210 -7667 M
INSERT 0 0 -0.049350 -3897 M
INSERT 0 0 0.000000 -233 M
INSERT 0 0 0.049030 3401 M
INSERT 0 0 0.100280 7209 M
INSERT 0 0 0.150260 10907 M
INSERT 0 0 0.200420 14608 M
INSERT 5 0 -0.200140 -15066 M
INSERT 5 0-0.150300 -11374 M
INSERT 5 0 -0.100320 -7667 M
INSERT 5 0 -0.049090 -3878 M
INSERT 5 0 0.000000 -230 M
INSERT 5 0 0.049610 3451 M
INSERT 5 0 0.099560 7142 M
INSERT 5 0 0.150160 10883 M
INSERT 5 0 0.200270 14573 M
INSERT 15 0-0.200160 -14986 M
INSERT 15 0-0.150210-11293 M
INSERT 15 0 -0.099660 -7583 M
INSERT 15 0-0.049790 -3892 M
INSERT 15 0 0.000000 -203 M
INSERT 15 0 0.049840 3482 M
INSERT 15 0 0.099920 7181 M
INSERT 15 0 0.150260 10880 M
INSERT 15 0 0.200420 14564 M
INSERT 25 0-0.200090 -14912 M
INSERT 25 0-0.150040 -11218 M
INSERT 25 0-0.099860 -7532 M
INSERT 25 0-0.050070 -3861 M
INSERT 25 0 0.000000 -170 M
INSERT 25 0 0.049810 3506 M
INSERT 25 0 0.100100 7203 M
INSERT 25 0 0.150120 10869 M
INSERT 25 0 0.200080 14540 M
INSERT 35 0-0.200190 -14854 M
INSERT 35 0-0.150240-11183 M
INSERT 35 0-0.099890 -7493 M
INSERT 35 0-0.049850 -3811 M
INSERT 35 0 0.000000 -134 M
INSERT 35 0 0.049730 3535 M
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INSERT 35 0 0.099900 7222 M
INSERT 35 0 0.150050 10895 M
INSERT 35 0 0.200080 14559 M
INSERT 45 0-0.200200 -14813 M
INSERT 45 0-0.150140 -11147 M
INSERT 45 0 -0.099850 -7449 M
INSERT 45 0-0.049670 -3754 M
INSERT 45 0 0.000000 -96 M
INSERT 45 0 0.049680 3565 M
INSERT 45 0 0.099920 7266 M
INSERT 45 0 0.150160 10937 M
INSERT 45 0 0.200170 14604 M
INSERT 59 0-0.200170 -14786 M
INSERT 59 0-0.150130-11111 M
INSERT 59 0 -0.099870 -7409 M
INSERT 59 0-0.049620-3712 M
INSERT 59 0 0.000000 -41 M
INSERT 59 0 0.049690 3634 M
INSERT 59 0 0.100140 7345 M
INSERT 59 0 0.150150 11016 M
INSERT 59 0 0.200190 14687 M
INSERT 64 0-0.200270 -14772 M
INSERT 64 0 -0.150060 -11082 M
INSERT 64 0 -0.100060 -7396 M
INSERT 64 0 -0.049680 -3652 M
INSERT 64 0 0.000000 -1 M
INSERT 64 0 0.050290 3699 M
INSERT 64 0 0.099560 7343 M
INSERT 64 0 0.150400 11086 M
INSERT 64 0 0.200360 14756 M
INSERT 69 0-0.200230 -14743 M
INSERT 69 0 -0.150640 -11066 M
INSERT 69 0-0.100150 -7371 M
INSERT 69 0 -0.049910 -3657 M
INSERT 69 0 0.000000 37 M
INSERT 69 0 0.049990 3741 M
INSERT 69 0 0.099770 7412 M
INSERT 69 0 0.150460 11148 M
INSERT 69 0 0.200270 14807 M
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